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Some abbreviations

AAL.: Anatomical Automatic Labeling template (Tzourio-Mazoyer et al.,
2002)
ALFF: amplitude of low frequency fluctuation
AFNI: Free software, website: http://afni.nimh.nih.gov/afni
fMRI: functional magnetic resonance imaging
GUI: Graphical User Interface
MRIcron/Mricro : Free software, website:
www.sph.sc.edu/comd/rorden/mricron/
ReHo: regional homogeneity analysis
REST: RESTing-state fMRI data analysis toolkit
ROI: region-of-interesting
SPM: Statistical parametric maps (Friston et al., 1995), a free software.
1. What can you do by REST
1. Batch processing of the fMRI data analysis;
2. Perform ReHo analysis, ALFF analysis and linear correlation
analysis;
3. Band-pass filter, remove linear trend of the fMRI data
4. Viewing the time series and power spectrum of the fMRI data
5. Define the ROI, extract the mean time series within the ROI;
6. Viewing the MRI image, display the fMRI result on a anatomical

image;
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7. Extract the specific cluster from the AAL template, Brodmann
temp late or statistic map, and create the mask image.

2. Notice before using REST

1. Image file format must be ANALYZE 7.5, and MRIcron or AFNI
(Cox, 1996) can be used to transform the format;

2. When processing the fMRI data by REST, fMRI data of each session
(or subject) must be stored in one folder volume by volume, i.e., each
pair of files (hdr/img) is one time point. All volumes must be named
in the order of the scanning sequence, e.g., the fMRI data of one
subject was stored in the independent folder, it means that there were
exactly all volumes in this folder and the files in this folder must like
this: a001.hdr/img, a002.hdr/img, etc. Remember that, the unwanted
image file must be moved out of the folder.

3. When using REST to define the seed voxel, if the coordinates of seed
was input manually, the original and the input coordinates of all
images must be corrected, and the position of ROI can be viewed
after clicking the “View ROI” button.

4. Cited this software as: RESTing-state fMRI data analysis toolkit

(REST, by Song Xiaowei, http://resting-fmri.sourceforge.net).
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3. Start to use REST toolbox
3.1 Installation

a) MATLAB 2006b for Windows XP was recommended.
b) Unzip the package, then start MATLAB, choose the option in toolbar
as following: File -> Set Path... -> Add Folder... (Here select the

REST folder)->Save->Close.
3.2 Remove the REST

Start MATLAB, and choose the option in toolbar as following: File -> Set
Path... (Here select the REST folder) -> Remove->Save->Close, then

delete the REST folder on the disk.

3.3 Start REST

1. Start MATLAB.

2. Enter “rest” in the command line (Figure 1).

1dow Help

e & 7 Current Directo

s dAMATLAR weork

: Toolbox Path Cache read in 0.09 seconds.
""""""""""" MATLAB Path initialized in 0.64 seconds.

To get started, select MATLAE Help or Demos from the Help menu.

== rest

I

Figure 1, Enter ‘rest’ to start REST toolbox GUI
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3. After typing “rest” in the MATLAB command line, the REST GUI

interface will popup (Fig. 2).

J REST 1.1

Resting State fMRI Data Analysis Toolkit

Figure 2. REST main interface.

3.4 Regional homogeneity analysis

3.4.1 What is regional homogeneity analysis

Kendall coefficient of concordance (KCC) (Kendall and Gibbons, 1990)
(Fig. 4) was used for measuring the similarity of the time series within a
functional cluster based on the regional homogeneity hypothesis (Zang et
al., 2004). 27, 19 or 7 nearest neighboring voxels (Fig. 3) were defined as
a cluster and a KCC value (range 0-1) was given to the voxel at the
center of this cluster (Zang et al., 2004). Recently, this method was

widely used in the resting-state study (Cao et al., 2006; He et al., 2004,
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2007; Liu et al., 2006; Wu et al., 2007; Zhu et al., 2005; Long X-Y et al.,

2008).

Figure 3. Nearest 7 voxels (yellow voexls and its up, down, left and right voxels), 19
voxels (except the 8 white voxels) and 27 voxels constitute a cluster.

Figure 4. KCC’s formula. Where W is the KCC among given voxels, ranged from 0 to

1; Ri is the sum rank of the ith time point; where R = ((n+1)K)/2 is the mean of the

Ri’s; K is the number of time series within a measured cluster (here, K could be 7, 19,
and 27, respectively; one given voxel plus the number of its neighbors); n is the
number of ranks (here n is the number of volume).

3.4.2 ReHo analysis
The GUI for performing regional homogeneity analysis will popup (Fig 5)

after clicking the ‘ReHo’ button at the REST main interface (Fig. 2).



REST

! Regional Homogeneity

Option: Remove Linear Trend
[ ] detrend
Option; [deal Band Pass Filter
[ ] Bandi Hz) - TR: (=)
Input Parameters
N
w
Diata Directory: E]
L Cluster hazk
()7 voxels (%) Defautt mask () Mo mask
()19 voxels () User's defined mask
(%) 27 wonels
ReHo | Doal |
Ot Parameters (ReHo map)
Prefix: Rehahiap Result: Prefix_Directoryhame {hdrimo
Directary: D MATLAE wvarkisUl_RehotReho_%1iSampleData E]
Divide ReHo brain by the mean swithin the mask(mPrefix_DirectaryMarme {hdrfitmg 11
hanual Operations
Help ‘ ‘ Divide hlean ‘ Slice Wiewer ‘ ‘ Power Spectrum ‘

Figure 5. The ReHo GUI.
3.4.2.1 Remove linear trend (optional)

Before calculating ReHo, there are some optional processes. First is the

option for removing signal linear trend.

Option: Remowe Linear Trend

[ ] detrend

Figure 6. The interface of linear trend removal.

In Fig. 6, if the “detrend” option was selected, the fMRI signal will be
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removed linear trend before the following process.

After selecting the “detrend” option, the “Detrend” button at right side
can be used. If this button was clicked, the process of linear trend
removal will be performed immediately for all of data which were
selected in the input window.

The output data will be saved in a new folder. This folder will be created
in the same directory with the original directory, and with a suffix
“ detrend”. For example, the input data was saved in the
“c:\data\OneCleanDir” directory, and the output data will be saved in the
“c:\data\OneCleanDir_detrend” directory.

Extremely Caution: If the ‘“c:\data\OneCleanDir_detrend” directory
already  existed, the REST will first delete  the
“c:\data\OneCleanDir_detrend” directory and then recreate the
“c:\data\OneCleanDir_detrend” directory and saved the data in this
directory.

3.4.2.2 Temporal filter (optional)

There is another optional process: temporal filter.

Option; [deal Band Pazs Filter

[ ] Band (Hz) P E;s: (=)

Figure 7. Interface of temporal filter.

In Fig 7, if the “Band (Hz)” was selected, temporal filtering will be
performed for the fMRI data before the following process. Moreover, if
the “detrend” option was selected, the temporal filtering will be

7
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performed after the linear trend removel procedure.

After selecting the “Band (Hz)” option, the “Filter” button at right side
can be used. If this button was clicked, the process of temporal filtering
will be performed immediately for all of data which were selected in the
input window.

The output data will be saved in a new folder. This folder will be created
in the same directory with the original directory, and with a suffix
“ filtered”. For example, the input data was saved in the
“c:\data\OneCleanDir” directory, and the output data will be saved in the
“c:\data\OneCleanDir_filtered” directory.

Extremely Caution: If the “c:\data\OneCleanDir_ filtered” directory
already  existed, the REST will first delete  the
“c:\data\OneCleanDir_filtered” directory and then recreate the
“c:\data\OneCleanDir_filtered” directory and saved the data in this
directory.

The cut-off frequency value and TR can be defined in the three separated
blank boxes. The first is the lower limit value and the second is the upper
limit value. The third is TR, the unit is second. For the Band-pass filter,
both boxes must be filled and the second value must higher than the first
value; for the high-pass filter, the second value must be zero, and the first
value must higher that zero (Fig. 8); for the low-pass filter, the first value

must be zero, and the second value must higher that zero (Fig. 9).
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Option: Ideal Band Pass Filter

Band[ Hz) | 001 | 0l TR (51| 2 Filter

Figure 8. High-pass temporal filter.
Option: Ideal Band Pass Filter

[+] Band( Hz) a E— w | 003 TR: (=) 2 Filter

Figure 9. Low-pass temporal filter.

3.4.2.3 Setting the input data

In this stage, the input data will be defined by the directory (Fig. 10). The
input data must be stored as mentioned above (please see details in
section 2. Notice before using REST). The input directory can be added or
removed in this interface (Fig 11). Multi subjects can be selected and

batch process can be implemented by this setting.

Input Parameters

W

Data Directory:

Figure 10. The interface of data input.

One directory can be added by clicking the button “...”. Moreover, in fig
11, a menu popup after right mouse click in the blank area. The directory
of input data can be added or removed in this way. If a directory was
selected, all of the subfolders in this directory can be added by choosing
“Add recursively all sub-folders of a directory”. The “Delete” and
“Backspace” button of the keyboard of a computer are available in this

interface.
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Input Parameters

M
Add a directory v
Data Directn~ Delete selected directory E]
Add recursively all sub-folders of a c.‘ie-:tm‘_-,-'
Clear all data directories

Figure' 11. Add all sub-folders of a selecting directory.
3.4.2.4 Define the mask option

In this interface, a brain tissue mask can be selected during the
calculating (Fig. 12). There are three options: default mask (provided by
REST, REST can automatically select a mask which match the size of the
input data), no mask (do not use mask during calculating) and user’s
defined mask (user can selected a self-defined mask). A mask can make

the calculating faster.

hask

() Default mask () ho mazk

(%) User's defined mask

CeTernpinask_MMI_ET _73_61.img E]

Figure 12. Mask definition interface. In this figure, a “User’s defined mask” was
selected, and the mask file was “D:\Temp\mask_MNI_61 73 61.img”.

The “Default mask™ options provide the following types of masks, the
masks were created based on the SPM MNI template. Voxels within the
brain can be selected by these mask. Their voxel size and dimension are:
B \oxel Size=3 mm x 3 mm x 3 mm, Dimension = 61 X 73 x 61;
B \oxel Size=3 mm x 3 mm x 3 mm, Dimension= 53 X 63 X 46;

B \oxel Size=2 mm x 2 mm X 2 mm, Dimension=79 x 95 x 69;
10
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B \oxel Size=2 mm x 2 mm x 2 mm, Dimension=91 x 109 x 91,
The mask can also be self-defined. The mask file could be ANALYZE 7.5
format (img/hdr) or mat file (variable name must be “mask”). The
directory of the mask can be entered into the blank or selected by clicking
the ““...” button.
3.4.2.5 Define the cluster size
As mentioned above (please see details in section 3.4.1), the cluster size

can be defined (Fig. 13). “27 voxels” is the most frequently used option.

L Cluster

() 7 voxels

(119 voxels

(%) 27 woxels

Figure 13. Define the cluster size in the ReHo GUI
3.4.2.6 Configuring the output directory

The output setting in ReHo analysis included prefix, directory for saving

the results and whether divide the global mean (Fig. 14).

Output Paraimeters (ReHo mag)
Prefis: Rehahtap Result: Prefix_Directaryhame {hdrimg

Directory: ol A TLAB wwrk

Divide ReHao brain by the mean within the mask(mPrefiz_DirectoryMame {hdrfimg 1)

Figure 14. Output setting interface.
About “Prefix:” REST will add a prefix and a underline with the name of

the input folder as the name of the output result. For example, if the input
directory was “c:\data\ OneCleanDir” and the prefix name if “ReHoMap”,
the name of the result will be “ReHoMap_OneCleanDir.img/hdr”. All

11
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results will be saved in the directory which can be defined in “Directory”
section or selected by clicking the ““...” button.

If the “Divide ReHo brain by the mean within the
mask(mPrefix_DirectoryName.{hdr/img})” was selected, a normalized
ReHo map which divide the global mean by using a brain tissue mask
will be generated, and a prefix “m” will be added to the result map. For
example, if the ReHo map was “ReHoMap_OneCleanDir.img/hdr”, the
normalized ReHo map is “m ReHoMap_ OneCleanDir.img/hdr”. These

two results will be saved in the same directory.

12
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3.4.2.7 Calculating the ReHo map

! Regional Homogeneity - O x

Option: Remove Linear Tremnd

s

Option; [deal Band Pazz Filter

[¢] Band( Hz) 001 | e 003 TR: (=) 2 Filter

Input Parameters
230% DoMATLAEwvork=U_Reho'Reho V1 SampleDatatest_ADHD-1 s
230% D:MATLAEwWvorkhZU_Reho'Reho Y 1'ZSampleDatatest_ Contral-1

v

Data Directory:  |DomaTLABwvorkyEUlRehoReho W1 SampleDatatest ADHD E]

L Cluster hlask
()7 voxels () Defautt mask () Mo mask
()19 voxels (%) User's defined mask

()27 voxels | aBwvorkiGlUlRehotReho_ V1 maskimask MM 7361 img E]

ReHO ‘ Do all ‘

Output Parameters (ReHo magp)
Prefix: Rehahdap Rehoiap_test_ADHD-1 {hdrfmo

Directory: DoMATLAEwvorkiZUl_RehotReho_v1SampleDataiout E]

Divide ReHo brain by the mean within the mask(mPrefix_DirectaryMarme {hdrfitmg 11

Manual Cperations

Help ‘ ‘ Divide Mean ‘ ‘ Slice Viewer ‘ ‘F’DWEF Spectrum‘

Figure 15. The demo for calculating ReHo maps
After clicking “Do all” (Fig. 16), the fMRI data will be processed as

following: i) remove linear trend; ii) band-pass (0.01~0.08 Hz) filtering;
1) Setting 27 voxels as a cluster, calculating the ReHo map voxel by
voxel: iv) ReHo map will be normalized by dividing the whole brain
mean by using brain tissue mask “mask_MNI_61 73 _61.img” (Fig. 15).

13
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Prefix of the output file is “ReHoMap” and “mReHo”. “ReHoMap”
indicated that the spatial map is a KCC map. “mReHoMap” indicated that
the spatial map is normalized. Generally, the “mReHoMap” will be
entered into the second-stastic analysis. All of the result maps (result
maps in Fig. 14 are RehoMap _test Control-1.img/hdr,
RehoMap_test ADHD-1.img/hdr, mRehoMap_test Control-1.img/hdr,
mRehoMap test ADHD-1.img/hdr) will be saved in the

“DAMATLABWork\GUI_Reho\Reho V1\SampleData\out” directory.
Eegiona Homogene ¥ cangyi@gma 1 BI

Option: Retnowe Linesr Trend
ReHo Computing ! O]

[] detrend BEFORE Filtter detrend AFTER Fitter

Current progress:

Option: Ideal Band Pass Fiter 1 Calculate the rank of time series

wait. ..

Band(Hz) | 001 |=w| 008 | TR(s)
Input Parameters @ . . .

2304 H: weishethdriced ] w_xisochunien_fitered_detrend B0% Elapsed 0:5:54, Remain 0:3:46  18:26:31 Started
2308 H: wiehethdricd wed_giuweigang_fitered_detrend
230# H:wiehethdricd ! vwd_mushufang_fitered_detrend |
230# H:wiehethdricd! wd_lihuangguo_fitered_detrend — .

230# H:wiehethdricd 1 'yod_zhaoxiani_fitered_detrend
230# H:wiehethdricd 1 yd_niusitong_fitered_detrend
230# H:wiehethdricd 1 'od_guajianying_fitered_detrend

) EeHo Computing

Total progress:

Data Directary: | H: iehethdricd wid_xisochunfen_fitered_d i :
H:hxiehebhdiedwd_lihuangguo_filtered _detrend
| Chuster sk
() 7 woxels () Defautt mask () Mo mask _ |
()19 vaxels @ User's defined mask 21% Elapsed 0:43:5, Remain 23443 17:49:21 Started |

(&) 27 voxels |'0gram File=tA TLABR 2006k wearkmask_MMI_E1_73_61 ima | E] ‘

ReHo

Output Parameters (ReHo map)

Erethe reho_wd_xisochunfen_fitered_detrend {

Directory: | H:ighethelricdl |E]

Divide ReHo brain by the mean within the mask(mPrefiz_DirectoryName {hdrime 1)

Manual Cperstions

Divide Mean

l Help l l Slice Wiewer Power Spectrum

Figure 16. ReHo map will be calculated after clicking “Do all”.
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3.5 ALFF analysis
3.5.1 What is the ALFF analysis

ALFF is the abbreviation of amplitude of low-frequency fluctuation. In
this analysis, the fMRI time series was transformed to a frequency
domain with a fast Fourier transform (FFT) (parameters: taper percent = 0,
FFT length = shortest) and the power spectrum was then obtained. Since
the power of a given frequency is proportional to the square of the
amplitude of this frequency component of the original time series in the
time domain, the square root was calculated at each frequency of the
power spectrum and the averaged square root was obtained across a
frequency band at each voxel. Generally, the frequency band of the
low-frequency fluctuation is 0.01 Hz to 0.08 Hz (Biswal et al.,1995; ).
This averaged square root was taken as the ALFF value (Fig. 17). This
method was used in the recent resting-state study (Yang et al., 2007; Zang

et al., 2007).

15
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450 Preprocessed . A
440 i .
430 | :'|-|
420 r I
410 |
0
] I 198
1400
1200 |
Power
1000
200 | ( Spectrum
BO0
400 t
200 t
0 &
0.01 0.08 Hz

Figure 17. Schematic illustration of the current ALFF analysis. The signal intensity is
measured inarbitrary units. (A) The fMRI time course. (B) Power spectrum using fast
Fourier transform. (C) Square root of the power spectrum between 0.01 and 0.08 Hz,
i.e., ALFF.

3.5.2 Start ALFF analysis
Click the “ALFF” button at the REST main interface (Fig. 2), the GUI for
performing ALFF analysis will popup (Fig 18). The usage of some

options is same with which also in the ReHo GUI.

16



REST

! Amplitude of Low Frequency Fluctuation - O
Option: Remove Linear Tremnd
[ ] detrend
Option; [deal Band Pazs Filter
[ ] Bandt Hz) ! TR: (=)

Input Parameters

Data Directory:

hazk
(%) Defaut mask ) Mo mask
() Uzer's defined mazk
Band( Hz) 001 | e~ 005 TR: (=) 2 Band Hint

ALFF

\ Doall |

Prefix:

Directory:

Output Parameters (ALFF magp)

ALFFMap Result: Prefix_DirectoryMarme {hdrfimg }

D MATLAE wrarkisUl_RehotReho_%1iSampleData Q

Divide ALFF brain by the mean within the mask(mPrefixz_Directorybame {horifmg 71

Manual Cperations

Help

‘ ‘ Divide hean ‘ ‘ Slice YWiewer ‘ ‘F’DWEI’ Spectrum‘

Figure 18. ALFF GUI.

3.5.2.1 Setting the ALFF parameters

Before performing ALFF analysis, the frequency band (e.g., 0.01 Hz and

0.08 Hz) and TR (e.g., 2 s) need to be defined (Fig. 19). The button

“Band Hint” can provide the hint about the frequency band.

17
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Eandl Hz) 001w~ 005 TR: (5] 2 Band Hint

Figure 19. ALFF parameters.
3.5.2.2 Output setting of ALFF

This option is similar with the same section in ReHo GUI (see 3.4.2.6

Configuring the output directory).

Output Parameters (ALFF mag)

Prefix: ALFFhap Result: Prefix_DirectoryMame . {hdtfimg

Directory: ol A TLAB wwark

Divide &LFF brain by the mean within the mask(mPrefix_DirectaryMame {hdrfimg 1)

Figure 20. ALFF output parameters.
3.5.3 Calculating the ALFF map

After clicking “Do all” (Fig. 21), the ALFF map for each fMRI data will
be calculated. The frequency band was 0.01 Hz to 0.08 Hz in this
example. ALFF map will be normalized by dividing the whole brain
mean by using a default brain tissue mask (Fig. 21, also see 3.4.2.4
Define a mask). Prefix of the output file is “ALFFMap” and
“mALFFMap”. “ALFFMap” indicated that the spatial map is a ALFF
map. “mALFFMap” indicated that the spatial map is normalized.
Generally, the “mALFFMap” will be entered into the second-stastic
analysis. All of the result maps (result maps in Fig. 21 are
ALFFMap_test Control-1.img/hdr, ALFFMap_test ADHD-1.img/hdr,
mMALFFMap _test_Control-1.img/hdr,
MALFFMap _test ADHD-1.img/hdr) will be saved in the

“DAMATLABWork\GUI_Reho\Reho V1\SampleData\out” directory.

18
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Option; Remowve Linear Trend

[ ] detrend

Optior: [desal Band Pazs Filter

|:| Band (Hz) 0.01 | 003 TR: (=) 2

Input Parameters

230# Do 'MATLAEworkWGU_Reho'Reho 1'SampleDatatest ADHD-1 »
230 DA TLABwWvorkZU_Reho'Reho W1 SampleDatatest Contral-1

W

Data Directory:  waTl aBweorky3U|RehoReho_1\SampleDatatest ADHD-1 [:]
Mzzk

(%) Defautt mask () Mo mask
() User's defined mask

Default

Bandi Hz) 0.01 | v | 0.05 TR: (=) 2
ALFF | Doal |

Cutput Parameters (ALFF magp)
Prefix: AL FFhtap ALFFMap_test ADHD-1 {thdrimo;

Directory: CoMATLAE wvork GU_RehoReho_v1\SampleDatatout

Divide ALFF brain by the mean within the mask (mPrefix_DirectoryMame {hdrfimg 1)

hanual Operations

Help ‘ ‘ Divide hean ‘ ‘ Slice YWiewsr ‘ ‘F’DWEI‘ Spectrum‘

Figure 21. The demo of ALFF analysis.

3.6 Functional connectivity analysis

Click the “Functional Connectivity” button at the REST main interface
(Fig. 2), the GUI for performing functional connectivity analysis will

popup (Fig 22). The usage of some options is same with which also in the

19
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! Functional Connectivity

= O =
Option: Retnove Linear Trend
[] detrend
Option: Ideal Band Pazs Fitter
[] Bandi; Hz) o TR: (=)
Input Paratmeters
”~
W
Data Directory: E]
—Set ROI Mask
(#) Default mask () Mo mask
(71 User's defined mazk
Covariahles: E]

Functional Connectivity

Output Parameters
Prefix FCMap Result: Prefix_DirectaryMame {hdrimo
Directary: dMATLAEWvorkigui_Rehoreho_yv1 E]
Fizher Z-zcore transformation within the maszkizPrefixz_DirectoryMarme fhdrfima

Manual Operations

| Help

| | Fisher £ | |S|i|:e Viewer| |F'nwer5pen:trum|

Figure 22. the functional connectivity GUI
3.6.1 Setting the parameters of functional connectivity
analysis

Before performing the functional connectivity analysis, the ROI and

covariate (if exist) need to be defined. REST provide two ways for

calculating the functional connectivity: Woxel wise (functional

20
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connectivity between ROI and each voxel within the brain) and ROl wise
(functional connectivity between two or more ROIs). The result of voxel
wise analysis is a spatial map. For the ROI wise analysis, a text file will
be created including the correlation coefficient matrix.
3.6.1.1 Define ROI
After clicking the “Voxel wise” button of the functional connectivity GUI
or “Add ROI” button of the ROI Definition List GUI (this GUI will
popup after clicking the “ROI wise” button of the functional connectivity
GUI, see Fig. 23), the ROl (Region of interest Definition interface will
popup (Fig. 24).
There are three kinds of ROI can be defined in REST:
(1) Seed ROI, i.e., a spherical ROl area defined by a center voxel’s
coordinates and the radius (unit: mm);
(2) ROI mask, here included four situations:
1) Extracted a cluster from a statistic map (after cut the threshold);
i) Extracted a brain area from AAL template (MNI temp late,
provided by MRIcro (Smith SM, 2002));
Iii) Extracted a brain area from Brodmann template (MNI template,
provided by MRIcro);
Iv) Self-defined mask file.
(3) A specific time series. The time series must be stored in a text file
(*.txt) as one column, and the length of this time series must be the
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same with the input fMRI signal.

First choose one kind as mentioned above, then click “Next” and set the
ROI. Click “Done” after finishing the ROI definition.

Extremely Caution: 1) The ROI position must be inspeted by visualization
after defining. This procedure can be done by clicking the “View ROI”
button; ii) In the seed ROI section, the view of the image in REST is as
following: positive value of the x coordinate located in the left of the
image, and positive value of the y coordinate located in the anterior part
of the image, and positive value of the z coordinate located in the superior
part of the image. The original coordinate of the image must be checked,
because REST will use the original coordinate to locate the position of

the seed.

! ROI Definition List ‘*

b

Misc w

| Done | | viewrol | | petste kol | | addror |

Figure 23 ROI Definition List. Here could add more than one ROI to performthe ROI
wise analysis. The mean time series can be extracted by choosing the related option in
Misc list in this interface.
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— () Seed ROl

Define a zeed ROl by setting the center coordinate and the radius(mm)

—(%) Ro

There are 4 methods to generate the RO maszk file:

(+) 1. From statistical t-rap by selecting cluster after thresholding

{1 2. From &AL template by selecting specific ares
3. Frotm Brodimann template by selecting specific ares

() 4. From user defined mask file

—(_) Time courses

Uzer defined time courzes contained in a txt file

[ Dione H View ROl ] Mext

Figure 24. Define ROI.
3.6.1.2 Add the covariates

The covariate’s directory can be defined in the “Covariables” section. The
covariates file could be text file (*.txt) or 1D file (extracted time series by
AFNI, *.1D), and each column of the input file is considered as a
covariate. If the covariate of each data was different, the covariate file
must be changed for each data when calculating. If the covariates of each
data were the same or no covariates were used, functional connectivity
analysis can be performed for the multi-data at one time.

Extremely Caution: If the covariate was used, REST will add the linear
trend to the covariates before calculating.

3.6.1.3. Fisher’s z transform
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In the “Output Parameters™ section, there is an option about Fisher’s z
transform (Fig. 25). The correlation coefficient need to be transformed to
the normal distribution by Fisher’s z transform before performing the
random effect t-tests. If selected, REST will calculate the Fisher’s z map
using the following formula:

1+r
1-r

z=0.5log

The result will be saved in the output directory with a prefix “z”. For
example, if the correlation coefficient map was
“FCMap_OneCleanDir.img/hdr”, then the z map will be *“z
FCMap_OneCleanDir.img/hdr”. It is also available for the text file of the

result of the ROI wise analysis.

Output Parameters
Prefis: Fichiap Result: Prefix_DirectoryMarme fhorime

Directory: D:M.&.TL.&BIWDrkIGUI_LDWREhD_W "SampleData |

Fizher Z-score transtormation within the mask (ZPrefiz_DirectoryMame . thdtfimg

Figure 25. Output setting of functional connectivity analysis.

3.6.2 Calculating the functional connectivity map

After clicking “Do all” (Fig. 26), the fMRI data will be processed as
following: i) remove linear trend; ii) band-pass (0.01~0.08 Hz) filtering;
iii) A spherical region of interest (ROI) (radius = 10 mm) was centered at
the given coordinates (—2, —51, 27), and the mean time series within this
ROI was considered the reference time course. Then a seed correlation
analysis (SCA) will be performed in a voxel-wise way. Prefix of the
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output file is “FCMap” and “zFCMap”. “FCMap” indicated the spatial
map is the correlation coefficient map, and “zFCMap” indicated the
spatial map is the Fisher’s z map. “zFCMap” can be used for the t-test.
All of the result maps (result maps in Fig. 26 are
FCMap_test _Control-1.img/hdr, FCMap_test ADHD-1.img/hdr,
zZFCMap_test_Control-1.img/hdr, zFCMap_test ADHD-1.img/hdr) will

be saved in the “D:\Temp” directory.
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! Functional Connectivity - 0 x

Option; Remowve Linear Trend

dletrenc Detrend

Option: Ideal Band Pass Filter

Band( Hz) 0.m e 005 TR r= 2 Filter
(=]

Input Parameters

2308 D WA TLABwWvorkzU_Reho'Reho W1 \SampleDatatest Contral-1 -
230% DMATLAEwvork=U_Reho'Reho V1 =ampleDatatest_ADHD-1

W

Data Directory:  IATLABWworkWSUI_Reho'Reho_1'SampleDatatest_Control-1 B
— et RO hzsk

{®) Defautt mask () Mo mask

RO wise

Covariahles: E]

Functional Connectivity ‘ Do all ‘
Output Parameters

() User's defined mesk

L

Prefix: FChiap FChap_test Control-1 {hdr i ¢

Directory: CriTetrp [:]

Fizher Z-zcore transformation within the mask(zPrefix_DirectoryMarme fhdriimg 1)

Matiual Operations

Help ‘ ‘ Fisher £ ‘ ‘Slice ‘v"iewer‘ ‘PDWEI’ Spectrum‘

Figure 26. The demo of functional connectivity analysis. In this example, the seed
ROI was setting through clicking “Voxel wise” button and then enter the center (-2,
-51, 27) and radius (10 mm) of ROI. “Covariables” was empty, so there was no
covariate used in this process.

3.7 Othertools

REST also provides series of tools for manual operations (Fig. 27, Fig.

28).
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hanual Operations

‘ Help ‘ ‘ Divide hean | alice Wiewer ‘ |F'|:|wer Spectrum‘

Figure 27. The manual options of ReHo and ALFF GUI.

Matiual Operations

‘ Help ‘ ‘ Fisher £ ‘ |Slice \fiewer‘ |F'|:|wer Spectrum‘

Figure 28. The manual options of functional connectivity analysis GUI.

® Help: Get the help document.

® Divide mean: In this option, the spatial map can be divided by that
map’s average value within a selected mask. After clicking it, a 3D
Image can be selected and calculated. The result image will be saved
in the directory of selected image with a prefix “m”.

® Fisher Z: In this option, the spatial map can be calculated by using the
Fisher’s z transform (see details in 3.6.1.3. Fisher’s z transform).
After clicking it, a 3D image can be selected and calculated. The
result image will be saved in the directory of selected image with a
prefix “z”.

® Slice Viewer: Similar with the MRIcro (Fig. 29). This tool can view
the image in orthogonal and multi-slice manner (Montage is also
available). It can also merge a low resolution image on a high
resolution image and select these two images from the same subject is
recommended. Slice viewer can view ROI, cut a threshold of overlay,
extract a cluster which included the selected voxel (left click the
mouse) in the overlay as a mask file, and draw the time series and its
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power spectrum of the selected voxel (left click the mouse) (Fig. 30).

Extremely caution when using slice viewer:

a) In REST coordinates, left is positive value and right is negative value
in the axis view; anterior of the image is positive value and posterior
of the image is negative value in the coronal view; superior of the
image is positive value and inferior of the image is negative value in
the sagittal view.

b) Slice viewer do not reverse the original image.

c) The entered coordinates must in term with the input image. If the
image was in the MNI standard space, the MNI coordinates should be
used during the analysis by REST. If the image was in the Talairach
view, the Talairach coordinates should be used during the analysis by
REST.

d) The coordinates showed in the slice viewer can be edited. The slice
viewer round the coordinates to show the voxel’s position. This
coordinates (X, Y, Z) is underlay’s coordinates. The coordinates of

overlay can be viewed by clicking the “Click to Toggle Hdr info”.
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Click to Toggle Hdr info

Slice Wiewer

[]voke Crosshair
¥Oraem)  S0mem)  Z(kaen)
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797100252
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Underlay: [ |
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4 | 4 |

) Slice Viewer — REST 1.1
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Figure 29. Slice viewer interface.

® Power spectrum: draw the time series and its power spectrum of the

selected voxel (left click the mouse) and viewed by slice viewer. If

this button was clicked, one volume which stored in the selected

folder need to be selected as the underlay and this tool will read all

volumes of the selected folder, and then show the figures (Fig. 30).

Voxel was selected by left mouse click.

29



REST

Resting State fMRI Data Analysis Toolkit

REST 2007 b

J DAMATLAB\work\GUI_Reho\Reho_V1\SampleData\Raw20070514\ - o %
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Copytight 2007-2010
ll rights reserved
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B Maruial Operations
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Figure 30. Time series and its power spectrum of one voxel viewed by REST.

4. \\ebsites

1. Main page: http://resting-fmri.sourceforge.net

a) Dowload:
http://sourceforge.net/project/platformdownload.php?group_id=19736
3)

b) Main page: http://resting-fmri.sourceforge.net/

c) Project page: http://sourceforge.net/projects/resting-fmri

d) Code and the program:
http://resting-fmri.sourceforge.net/index REST Codes.html
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